Directions to submit an Expansion Application due to
Change/Update in NAICS Code:

Step 1: Log into https://hdot.dbesystem.com



https://hdot.dbesystem.com/

Step 2: After you have logged in with your user name and password, click on the “Home” link on the
left side of menu under the HDOT emblem
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account, please contact us through the messaging system: from the left menu, click Message. then Contact System Support.

Click on the “Home” link on the left side of
view » menu under the HDOT emblem

Search »

visible at all times_
E. and identifies if immediate action is required.

imenu, click Search, then select the type of record you need to find. For tips on searching the system, download the Quick Guide listed below.
Message »
Settings >

Help & Support > b options are available from the left menu under Help & Support, including our online help system, a Forums module, and messaging tools

I« Do not show this page again.

Logoff
Show all Hide all

Customer Support
Copyright @ 2018 B2Gnow. All rights reserved.
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Step 3: Under “Key Actions” click on the “Apply for Certification/Manage” link

Q °|° https: //hdot.dbesystem.com/FrontPage/VendorMain.asp?XID=5223
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File Edit View Favorites Tools Help

Displaying records assigned to  your company

f - "4% Dashboard
3

Active Pending Renewing

o 1 [}

Certification Center

#, If your firm holds active certifications {SBE/MBE/WBE/DBE/HUB/etc) from any organization, submit a request to add them to your account.

Search »
Message >
Settings »

Help & Support >
Logoff

Shew All Hide all

Click on the “Apply for
Certification/Manage” link

Take a Training Class

Alerts

Mo Activated Alerts. View Pending Alerts)

System News

@ Special Features for Vendors

If your firm is certified (SBE, DBE, MBE, WBE, etc.), active records will appear in the "Cartification Centar” on the left side of this Dashboard. You can take two
important actions:

1. Add a date alert to an active certification to remind you of an upceming renswal. You can add multiple alerts to any active certification -- for example 90 days, &0
days, and 30 days bafore the renewal is dus.

2. If your firm holds a certification that is not listed, submit a missing certification request. Gur customer support team will review the supparting documentation
and take action to =dd the record to ensure your profile is complete and up-to-date.

Training Classes & Events
Learn more about the system with cur regular training classes and see upcoming events relevant to your business. Wiew details.

- View events & RSVP today

@ View New System News

Configure

Business Info

Profile Setup

List/Add Users

Main Contacts
Commodity Codes
EEQ/Waorkforce Comp.

Change Your Bassword
Edit Your User Account Settings

Customer Support
Copyright © 2018 B2Gnow. All rights reserved.
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Step 4: Under “Select an Option” — click on the “Your firm is currently DBE/ACDBE certified by HDOT” link
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%w "y Welcame to the Hawaii Department of Transportation (HDOT) online certification application for Disaduantaged Business Enterprises/Airport Cancession Disadvantaged Business Enterprises (DBEFACDEE). Need Heln?
Sorn eed Help?

Aloha! Thank you for your interest in participating in the Hawaii Department of Transportation's (HDOT) Disadvantaged Business Enterprises (DBE/ACDBE) Program. As mandated by the United 5tates Department of Transportation’s (U.5. DOT) DBE/ACDBE Regulations, (49 Code of Federal o load B 5 of
ownload Part 2 o

Qo2 &P Regulations (CFR), Part 26), all U.S. DOT recipients of federal financial assistance must participate in a statewide Unified Certification Program (UCP). The UCP is a "One-Stop” certification procedure established to eliminate the need for DEE/ACDBE firms to apply for certifications from
Home multiple state or local public agencies that are required to have a DBE/ACDBE Program as a condition of receiving U.5.DOT funds. the user manual
View > The HDOT Office of Civil Rights is charged with the responsibility of certifying firms and compiling and maintsining a datsbase of certified DBE/ACDBES for LS. DOT recipients, pursuant to 48 CFR Part 26. HDOT is the certifying agency for the Hawaii UCP and will process all applications and | 2204 for s Training

maintain the database of certified DEE/ACDBE firms for the State of Hawaii. Clsss

Search >
Message » You can electronically submit an application for:

Settings »

* Mew DBEFACDEE Certification
Help & Support >
* DBE/ACDBE Annual Affidavit of No Change

Logoff
Show All Hide All * Interstate DBE/ACDBE Certification
* Report Changes or Request Expansion of Wark Codes
Click below for more information regarding the DBE/ACDEE qualification criteria.
View All Definitions and Qualifications for DBE/ACDBE Ce
For mare information on the DBEFACDEE program, please visit the DEE/ACDE,
- . «“ . .
select an Option Click on the “Your firm is
Your firm is currenty DEEFACDBE certified by HDOT. Curren tly DBE/A CDBE Certl:fIEd
Your firm is not currently certified by HDOT.
[ Return to Certification List
Customer Support Home | Help | Print To PDF
Copyright @ 2018 B2Gnow. All rights reserved.
Logged on as:
Ghost Lee
HDOT Ghost
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Step 5: Under “Select an Option” click on the “You would like to report a change or update your certification record” link
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’Por "'.p Welcome to the Hawaii Department of Transportation (HDOT) online certification application for Disadvantaged Business Enterprises/Airport Concession Disadvantaged Business Enterprises (DBE/ACDBE). Need Helo?
leed Help?
Aloha! Thank you for your interest in participating in the Hawaii Department of Transportation's (HDOT) Disadvantaged Business Enterprises (DBE/ACDBE) Program. As mandarted by the United States Department of Transportation’s (U.5. DOT) DBE/ACDBE Regulations, (49 Code of Federal
= = &b Regulations (CFR), Part 26), all U.5. DOT recipients of federal financial assistance must participate in a statewide Unified Certification Program (UCP). The UCP is a "One-Stop” certification procedure established o eliminate the need for DEEFACDBE firms to apply for certifications from Download Parc 2 of
Home multiple state or local public agencies that are required to have a DBE/ACDBE Program as a condition of receiving U.5.D0T funds. the user manual
View > The HDOT Office of Civil Rights is charged with the responsibility of certifying firms and compiling and maintaining a database of certified DBE/ACDBEs for .5, DOT recipients, pursuant to 49 CFR Part 26. HDOT is the certifying agency for the Hawaii UCP and will process all applications and 2ign wp for a Training
maintain the database of certified DBE/ACDBE firms for the State of Hawaii. Llsss
Search »
Message » You can electronically submit an application for:
Settings »

* Mew DBEEFACDBE Certification
Help & Support >

* DBE/ACDBE Annual Affidavit of No Change
Logoff

Show All Hide Al * Interstate DBE/ACDBE Certification

* Report Changes or Request Expansion of Work Codes

Click below for more information regarding the DBE/ACDEE qualification criteria.

View All Definitions and Qualifications for DBE/ACDBE Certification

For mare informartion on the DBEFACDBE program, please visit the DBEE/ACDBE Program page.

Select an Option

Your firm is currenty DBE/ACDBE certified by HDOT.

Click on the “You would like to

You would like to submit your Annual Affidavit of No Change (AAMNC).

You would like to report a change or update your certification record. report a Change or update your
Your firm is not currentdy certified by HDOT, Certification record" |ink

[ Return to Certification List l

Home | Help | Print To PDF

Customer Support
Logged on as: Copyright @ 2018 B2Gnow. All rights reserved.
Ghost Lee 5
HDOT Ghost
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Step 6: Under “Select an Option” click on the “Add/update commodity, supply, and/or service work categories on your
certification” link
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File Edit View Favorites Tools Help

féﬁ;&x Certification Application: Available Applications
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%or "J Welcome to the Hawaii Department of Transportation (HDOT) online certification application for Disadwvantaged Business Enterprises/Airport Concession Disadvantaged Business Enterprises (DBEFACDBE). Need Help?
et eed Help?
Aloha! Thank you for your interest in participating in the Hawaii Department of Transportation's (HDOT) Disadvantaged Business Enterprises (DBE/ACDBE) Program. As mandated by the United States Department of Transportation’s (U.5, DOT) DBE/ACDBE Regulations, (49 Code of
s = Federal Regulations (CFR), Part 26}, all U.S. DOT recipients of federal financial assistance must participate in a statewide Unified Certfication Program (UCP). The UCP is a "One-Stop” certification procedure established to eliminate the need for DBE/ACDEE firms to apply for certifications | Downlosd Part 2 of
Home frem multiple state or local public agencies that are required to have a DBE/ACDEE Program as a condition of receiving U.S.DOT funds. the user manual
View » The HDOT Office of Civil Rights is charged with the responsibility of certifying firms and compiling and maintaining a database of certified DBE/ACDBEs for U.5. DOT recipients, pursuant to 49 CFR Part 26. HDOT is the certifying agency for the Hawaii UCP and will process all applications Sign up for s Training
and maintain the database of certified DBE/ACDBE firms for the State of Hawaii. Llass
Search »
Message > You can electronically submit an application for:

Settings »

Mew DBEFACDBE Certification
Help & Support »

+ DBE/ACDBE Annual Affidavit of No Change
Logoff
Show All Hide All * Interstate DBE/ACDBE Certification
* Report Changes or Request Expansion of Work Codes
Click below for more information regarding the DBE/ACDEE qualification criteria.
View All Definitions and Qualifications for DBE/ACDBE Certification
For more information on the DEEFACDEE program, please visit the DEE/ACDEE Program page.
Select an Option
Your firm is currenty DBEFACDBE certified by HDOT.
You would like to submit vour Annual Affidavit of Mo Change (AANC).
You would like to report a change or update your certification record. CI iCk O n th e ”Add/u date CO ” ] ” _’ Odit
Update ONLY business name. DBA name, address, phone. fax. and/or email. p y
. .
supply, and/or service work categories
Your firm is not currently certified by HDOT. 0 0 o
on your certification” link
[ Return to Certification List l
Logged on as:
Ghost Lee

HDOT Ghost
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Step 7: Under “Select an Option” click on the “Submit an Expansion application” link

g @ | @ https://test. mwdbe.com/FrontPage/Vendorhain.asp?XID=2022
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File Edit View

Favorites Tools Help

Test
System

Certification Application: Available Applications

B2GNeW

View »

Search »
Message >
Settings »

Help & Support >
Logoff

Show All Hide all

Logged on as:
Ghost Lee
HDOT Ghost

Welcome to the Hawaii Department of Transportation (HDOT) online certification application for Disadvantaged Business Enterprises/Airport Concession Disadvantaged Business Enterprises (DBEFACDBE).
Aloha! Thank you for your interest in participating in the Hawaii Department of Transportation's (HDOT) Disadvantaged Business Enterprises (DBE/ACDEBE) Program. As mandarted by the United 5tates Department of Transportation’s (U.5. DOT) DEE/ACDBE Regulartions, (42 Code of
Federal Regulations (CFR), Part 26), all U.5. DOT recipients of federal financial assistance must participate in a statewide Unified Certification Program (UCP). The UCP is a "One-Stop” certification procedure established to eliminate the need for DBE/ACDBE firms to apply for certifications

from multiple state or local public agencies that are required to have a DBE/ACDBE Program as a condition of receiving U.5.DOT funds.

The HDOT Office of Civil Rights is charged with the responsibility of certifying firms and compiling and maintaining a database of certified DBE/ACDEEs for U.S. DOT recipients, pursuant to 48 CFR Part 26. HDOT is the certifying agency for the Hawaii UCP and will process all applications
and maintain the database of certified DBE/ACDBE firms for the State of Hawaii.

You can electronically submit an application for:

* Mew DEE/ACDEE Certificaton
* DBE/ACDBE Annual Affidavit of No Change
* Interstate DBE/ACDEE Certification

* Report Changes or Request Expansion of Wark Codes

Click below for more informarion regarding the DBE/ACDBE qualification criteria.

View All Definitions and Qualifications for DBE/ACDBE Certification

For more information on the DEE/ACDEE program, please visit the DEE/ACDEE Program page.

Need Help?

Download Part 2 of
the user manual

Sign up for a Training
Class

Select an Option

Your firm is currenty DBE/ACDBE certified by HDOT.

¥ou would like to submit your Annual Affidavit of No Change (AAN

¥ou would like to report a change or update your certification

Update OMLY business name, DBA name, address, p

Add/update commodity, supply, andfor service g

Click on the “Submit an Expansion
application” link

@ Submit sn Expansion applicatian.

Your firm is not currently certified by HDOT.
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Expansion Application for Hawaii Department of Transportation
Step 8: Complete Company & Contact Information, if it is not already pre-filled

Step 8A: Complete Eligibility Requirements — Updating Commodity Codes - answer Yes or No in radial button
Step 8B: Click the “Continue” button when complete

g @ | @ https://test. mwdbe.com/FrontPage/Vendorhain.asp?XID=2022

File Edit View Favorites Tools Help

Test  certification Application: Start Certification Application
System

B2GNe\w EXxpansion Application for Hawaii Department of Transportation

- = &y Lxpansion application to report changes to your certification eligibility ands/or request updates to your commodity codes and work descriptiorn.

F=mrn =
|

O-ac || @ Diversity Management Syst... % | {n} %7 22

Help & Tools N

This application is for firms seeking to expand commaodity codes and report changes to certification. Need Help?
View »
D. load Part 2 of
Search » .
Company & Contact Information
Message >

the user manual

Sign up for a
Training Class
Settings »

Select a company type and application auto-fill cption. Confirm or enter your personal and company g ‘esses to permit us to contact you quickly for technical support, if needed.

Help & Support > YOUR EMAIL ADDRESS *

p— N 1%t: Complete Company &
| companrmes Contact Information, if it is not
APPLICATION AUTOFILL * a I re a d y p re_fi | I e d review and lock-in the auto-filled information to ensure it is accurate and correctly formatted.Select an option below:

pn - Relevant previous application data will be copied to the new record.
DEE Application

Eligibility Requirements

The following basic criterion is used to evaluate eligibilicy for ce

e e 26107 o 9. pre 2, g ey 2. 153 2"d: Complete Eligibility Requirements —

o frm saeking o updaceyour commadiny oS Updating Commodity Codes - answer
O ves O No . .
Yes in radial button

intended as a general overview to see if your firm should apply for certification.

rowided incorrect information or made false statements, the Department may initiate suspension or debarment proceedings
Justice for criminal prosecution under 18 U.5.C. 1001, which prohibits false statements in Federal programs.

, 3rd: Click the “Continue” button when
—
complete

Logged on as: Customer Support
Ghost Lea Copyright @ 2018 B2Gnow. All rights reserved.

Home | Help | Print To PDFE
HDOT Ghost
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Step 9: Click “Check this box and click Continue to start the application process”

Step 9A: Click “Continue” to start the application process

Q@|° https://test. nwdbe.com/FrontPage/VendorMain.asp?XID=2022 P-ad || 0 Diversity Management Syst... | |

File Edit View Favorites Tools Help

Test Certification Application: Document List Preview for LLC
Sysiem

In addition to completing an application form, you will be required to submit supporting documents with your application. These documents must be submitted in electronic format. Applications submitted with elecoronic documentation are able to be received by HDOT and reviewed faster. Processing of

BZG N“W applications submitted with hardcopy documentation cannot begin until the documents are received by the organization.
= = % Mandatory documents must be submitted with yolapplication; there are no exceptions. Required documents must be submitted if applicable to the type of your firm and nature of its work. If you hawve any questions, please contact HDOT's Office of Civil Rights before starting.
Home
Review the iterms below before beginning the proce sure you are able to and are comfortable providing the requested information. If you are unable or unwilling to provide the Mandatory documents, do not proeceed. Failure to submit the attachments without an explanation as to why any such attachment
View » was not provided will result in a delay in processing firm could ultimately be denied certification.
Search » - ) .
This docum)| application (click the Decuments tab). You can also print the list to your printer or a PDF file.

Message > .
.
Settings » : Check this
S [« Check this box and click Continue to start the application process.
Help & Support >
b OX ALERT: to ensure security of your application, only YOU will have access to this application once it is created. By starting the application, it will be assigned
Logoff to you throughout the process, and no one else can access unless you reassign it to another user for completion or explicitly grant access by clicking the
Shaow All Hide all Utilities tab and adding a user to the Access List.
Application Timeline: you will have 90 days to complete and submit this application. Otherwise, the record will self-delete on 5/29/2018. Periodic
reminders will be sent te you by email up to that peint. A deleted application cannot be recovered; you will need to start again.
Continue l l Return l
Required Documents
Required documents must be provided when applicable to your firm. Failure to submit a required document without an exp, chment was not provided will result in a delay in processing and/or could result in denial.
Licenses, license renewal forms, permits, and haul authority forms
Additional supporting documents not listed
nd. Click
.
2"¢: Clic
0
Costomer supsers Continue to s 1Sl 1 ant T 70
Copyright © 2018 B2Gnow. all rights reserved.
lication

Logged on as:
Ghost Lee

HDOT Ghost
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Step 10: Under Sections and Documentation — Section 1: General Information - Click on “Process” button

Q @ hitps://test. mwdbe.com/FrontPage/Vendorhain.asp?

File Edit WView Favorites Tools Help

Test Certification Application: Main Summary Help & Tools 3¢
system

L-ac || 0 Diversity Management Syst... | |

Main | Documents Slgnature| Subm|t| Utllllles| Gert List

BZG N&W HDOT Ghost Application status: Incomplete
Application Type: EXxpansion Application Application startad: 2/28/2018
&= =% ) Application Number: 9041681

0% complete

Home Fill in each of the sections noted below by clicking the Process buttons. You can complete the sections in any order, and the system will save your information as you go. Once all sections have been completed, the application will be complete and you will be able fo sign and submit. 4 .
Need Help?
View > The Contact Person noted below is the only user authorized to access this application. If someone else needs access, change the contact by clicking the drop down menu or grant them access on the Utilities tab. Download Part 2 of
Search » the user manual
Sign up fora
LE==rE Training Class
Settings »

Help & Support »

Application Informa

Logoff

Show All

Application Type
Certifying Agency
Business Name
Current Status
Application Number
Date for Deletion

Expansion Application
Hawaii Department of Transportation
HDOT Ghost
Incomplete
9041681

5/29/2018 (Extend)

Contact Person Ghost Lee| | | (Add user not d

This is the assigned usar for this 2 To =nsure security of tha application, only YOU have access to this application unless you reassign it to anothar user for completion or explicitly grant access by clicking the Utilities tab and

Sections and Documentation CI i c k O n “ P r O C e S S V4

Section 1: General Information

*| Process |

Section 2: Business Information b utto n *| Process | Incomplete: O completed of 10 required; 0 completed of 0 optional

‘| Process |

Incomplete: 0 completed of 8 required; O completed of 4 optional

Document List Incomplete: O attached of 0 mandatory; 0 attached of 2 required

Signature and Submittal

Signature
Submittal
| Delete Application |
Customer Support Home | Help | Print To PDF

Copyright © 2018 B2Gnow. All rights reserved.

Legged on as:
Ghost Lee
HDOT Ghost
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Step 11: If you would like, complete each section in YELLOW and click “Save & Return to Application Summary” button — these
are not required

e@|° https: //test. nwdbe.com/FrontPage/VendorMain.asp?XID=2022 L-acdc || 0 Diversity Management Syst... |
File Edit View Favorites Tools Help

T88t  certification Application: Section 1: General Information

=
System

T 27 €27
e | Sssumens | sinsre | swom | imes | cen Lax

:
ey B N Color Coding Legend T
—
Home Piease answar all uastions 35 completely 35 possiole and that are applicatie to your business. Cusstons highlighiad In red are requirad and must be complstad In order i submit your application. If 3 raguired fizld s not applicabia to your fimm mark 1 35 MiA. QuesSions highighted In yellow are optional; plesse com| . . Guestion Cator Coan
Pink — required response S
—
:
Yellow — optional response

Grey - completed

mmmmm Drart fraquarly while TIIING out T2 SN 50 SNSUNS INE1 YOUr INONTISS0N |5 53ved. GRo2 S3wed, YoU C3N resum (0 e S3cUon 3t any 1ima 10 CNtnuS. SOMe QUSSTISRE MY MOt B3 ENRGWn 1N Ihis S2CT0N OUS 1 YOUr campany typa

Campi=te

SaveDraft | | Save & Retum to Application Surmmary | | Cance |

e
hew Al a2 Section Status
Zection 1: Genaral Information Section Status. Incamplete

plet
- & Incompista out of € raquired
- 4 Incomplets out of 4 optional

T *required fields o
. 1 A. Name of Business* _
| === 1 B. DBA Name
wis = 1C.Physical Address*
E— wer. 1 D. Mailing Address * -
== 1. Telephone Number *
e 1 F. Fax Number -
e - 1 G. Mobile Phone Number
1o e e _ 1 H. Internet Web Site /URL Address
e s s 11. E-mail Address *
R — 1 J. Tax ldentification Number * =

LERRRRRRY

Save Draft | | Save & Rewm to Application Summary

£
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Step 12: Under Sections and Documentation — Section 2: Business Information - Click on “Process” button

0 hitps: //test. mwdbe.com/FrontPage/VendorMain.asp X L-ac || 0 Diversity Management Syst... | |

File Edit WView Favorites Tools Help

Tast Certification Application: Main Summary
System
Main | Documents | Signature | Submit | Utilities | Gert List
BZG NUW HDOT Ghost Application status: Incomplete
Application Type: EXxpansion Application Application startad: 2/28/2018
= =5 Iﬂ =h Application Number: 9041681 — -

Home Fill in each of the sections noted below by clicking the Process buttons. You can complete the sections in any order, and the system will save your information as you go. Once all sections have been completed, the application will be complete and you will be able fo sign and submit. 4 .
Need Help?
View > The Contact Person noted below is the only user authorized to access this application. If someone else needs access, change the contact by clicking the drop down menu or grant them access on the Utilities tab. Download Part 2 of
Search » the user manual
Sign up fora
LE==rE Training Class
Settings »
Help & Su rt > = =
B B Application Informa
Logoff Application Type Expansion Application
Show All Hide All Ceriifying Agency Hawaii Department of Transportation
Business Name HDOT Ghost
Current Status Incomplete
Application Number 9041681
Date for Deletion 5/29/2018 (Extend)
! FEEE Ghost Leeﬂ Add)
This is the assigned us= tion. To ensure security of tha application, only YOU have access to this application unless you reassign it to anothar user for completion or explicitly grant access by clicking the Utilities tab and

Sections and Documentatic Under SeCtionS and
Section 1: General Information DOC u m e ntat i O n _ Se Cti O n 2 : Complete: & completed of & required; 0 completed of 4 optional (by Ghost Lee, 2/28/2018)

Section 2: Business Information * Process | Incomplete: O completed of 10 required; 0 completed of 0 optional

Document List BUSineSS I nformation = CIiCk On * Process | Incomplete: 0 attached of 0 mandatory; 0 attached of 2 reguired
Signature and Submittal ”PrOCESS “ b Utton

Signature X | sign |
Submittal 2 | submit |
Delete Application |
Customer Support Home | Help | Print To PDF

Copyright © 2018 B2Gnow. All rights reserved.

Legged on as:
Ghost Lee
HDOT Ghost
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Step 13: Under Sections and Documentation — Section 2: Business Information — answer the questions No or Yes (Yes requires
response) and upload/attach supporting documents, as needed/applicable

= e =508

GI:: :_\:l|° https://test. nwdbe.com/FroentPage/VendorMain.asp?XID=2022 D~-ac || & Diversi ty Management Syst... | | Y A T

File Edit View Favorites Tools Help
Help & Tools 3§
~

v Test Certification Application: Section 2: Business Information
Application status: Incomplete

System
Application started: 2/28/2018

Main | Documents | Signature | 5ubmit| Utilﬂies| Cert List
B2GNe\VY HDOT Ghost
application Type: Expansion Application .
& [&] &b Application Number: 9041681 Co | or Cod i ng Lege n d
o s complet=

Home Please answer all questions as completely as possible and that are applicable to your business. Questions highlighted in red are required and must be completed in orde 5 5 Question Color Coding
e are optional; please complete all those that apply to your business. PI n k — req u I red res po n se feuirad & incompiete
. Click Save Draft frequently while filling out the form to ensure that your information is saved. Once saved, you can return to the section at any time to continue. Some que ) optionsl & incomplete
— Yellow — optional response —
Settings »
Help & Support > Save Draft | | Save & Return to Appl| G rey = Co m p | eted
Logoff * required entry

Show All Hide Al Section Status

Section 2: Business Information Section Status Incomplete
- 10 incomplete out of 10 required

Section Questions

2.A. Is the firm adding or changing its work descriptions? + r'e q u i re () ie () S Required

If yes, describe changes below.

N 2.A. Is the firm adding or changing its work descriptions?*
o 2.B. Is the firm adding or changing its services?*
oo 2.C Isthe firm adding or changing its commodity codes?*
© T emammwo. 2.D. Have there been any changes in the control of the company in the last 12 months?*
o ves 2.E. Have there been any changes in the Officers in the last 12 months?*
2.F. Have there been any changes in the Board of Directors in the last 12 months?*
2.1 me nm scaing or cnanaing 1s commesny covesz - ) G, Have there been any changes in the legal structure of the firm in the last 12 months?* «s
2.H. Have there been any changes in the ownership of the company in the last 12 months?*
o 2.1. Have there been any changes in the disadvantaged status of the firm in the last 12 months?*

ity 2.J. Have there been any changes in the management of the company in the last 12 months?* ~

HDOT Ghost < >
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Step 14: Click on Instructions for attaching files — click here to show. Read pop up and follow directions

\ 00 Management
File Edit View Favorites Tools _Help A fOr —

View >
Search »
Message »

Settings » N " P . .
el Attach an electronic file File limitations of electronic attachments
Help & Support »
1. To attach an electronic file, click the Attach link The types of files that you can attach are restricted to maintain system security. PDF format is recommended for all
In the popup window (you may need to allow your Internet browser to permit popup windows), click the Browse attachments.
button to find the relevant file. Other files types may not be easily readable by staff and may delay the review of your application. TIFF/TIF formatted
. Click Attach File to upload to your application; for larger files it may take several minutes for the process to complete, files are not recommended.
depending on your Internet connection. Attached files are limited to 30.0 MB. This is not a limitation of the system, but a reasonable maximum size that staff
. You can attach multiple files to each document type, but take care to attach the correct document(s) for each one. users are able to open and view on their computers.

. You can upload as many files as needed for a particular document type. Larger files cannot be easily read or printed. If your electronic files exceed the 30.0 MB limit, you will need to rescan

- at a lower resolution or compress the file.
. Once the file has uploaded, you can close the pop up window.

If & document is not applicable to your firm or situation and is not & mandatory document, click Not Applicable. Once all docume are aftached or marked as not applicable, this section will be complete.

Read pop
up and
follow

directions

to attach

R file(s)

Ghost Lee
D 1:26 PM
|||E§ _ R DR

HDOT Ghost




Step 15: Once you have uploaded all your documents, click the “Return” button
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Search »
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Ghost Lee
HDOT Ghost

Certification Application: Document List

Main | Documents l 5|gnature| 5ubmi‘t| Utllrliesl Cert Lisl|
HDOT Ghost Application status: Complete, Pending Signature > Sign Application
Application Type: EXpansion Application Application start=d: 2/28/2018
Application Number: 9041681

98% complete

Mote that some documents are required due to the nature of your firm. Failure fo submit the attachments without an explanation as to why any such attachment was not provided will result in a delay in processing andfor could result in denial

Instructions for attaching files = click here to show

Note: this application allows faxing of documents to the system. To use this opfion, click the Attach All Docs Via Fax button below or any individual Fax link to display and print a fax cover page. Additional instructions will be included on the cover page. All copies of confracts, agreements, and other documents requiring a signature
to be valid must be submitted in their signed form_

Please note that as a condition of your application for cerification, you are reguired to maintain in your office the original decuments provided. HDOT will review these original documents, including the signed and notarized cerification affidavit, during the site visit, if applicable. Furthermore, HDOT reserves the right fo inspect in

person andfor request original documents by mail of any supporting document at any time during the term of certification.

CEELTET L e Complete: 0 attached of 0 mandatory; 2 attached of 2 required

Document Format Electronic documents only.
This document checklist is used to securely and confidentially attach electronic files to the application.

[ Refresh List l [ Attach All Docs Via Fax l [ Return l

equired Documents
Required documents that are not relevant to your firm can be marked as not applicable. Please use caution when reviewing the document list as failure to submit the attachments without an explanation as to why any such attachment was not provided will result in a delay in processing and/or could result in denial.

Attach (Refresh) "ot':\a;;‘“::ble Document {Refresh) D":’“"’ad Document Description (Refresh) Status (Refresh)

Attach each document belew or check the box to indicate it is not applicable to your business; then click the Lock In button.
- Attached by Ghost Lee on 2/28/2018

- Licenses, license renewal forms, permits, and haul authority forms

Attach or Fax
brochure2017Dec.doc (DOC, 2.71 ME)
View File Edit Info Delete File

Attach or Fax - Additional supporting documents not listed Attached by Ghost Lee on 2/28/2018
Size Standards Table 2017 - only.xlsx (XLSX, 63.51 KB)

View File Edit Info Delete File

Attach each document above or check the box to indicate it is not applicable to wour business: then click the Lock In button. .
- — Click “Return” button once all the
documents are uploaded

Home | Help | Print To PDE

Customer Support
Copyright & 2018 B2Gnow. All rights reserved.
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Step 16: Click the “Sign” button
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Message >
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Logoff
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Logged on as:
Ghost Lee
HDOT Ghost

Certification Application: Main Summary

Main | Documents | Signature | Submit | Utllrlles| Cert List

HDOT Ghost Application status: Complete, Pending Signature > Sign Application
Application Type: EXpansion Application Application started: 2/28/2018
Application Number: 3041681

O8% co

All sections have been completed and the application is complete. Click the Sign bufton to electronically sign the application B .
Need Help?

Download Part 2 of
the user manual

Sign up for a
Training Class

Application Information

Application Type Expansion Application

Cerfifying Agency Hawail Department of Transportation

Business Name HDOT Ghost

Current Status Complete, Pending Signature > Sign Application
Application Number 9041681

Date for Deletion 5/29/2018 (Extend)

ECREERE R Ghost Lee ﬂ (Add user not on list)

by clicking the Utilities tab and

This is the assigned user for this spplication. Te ensure security of the apelication, only YOU have access to this application unless you reassign it to another user for completion or explicitly grant acc
2dding a usar to the Access List.

Sections and Documentation

Complete: 6 completed of 6 reguired; 0 completed of 4 optional (by Ghost Lee, 2/28/2018)

Section 1: General Information
Section 2: Business Information Complete: 10 completed of 10 required; 0 completed of 0 optional (by Ghost Lee, 2/28/2018)

Document List Complete: 0 attached of 0 mandatory; 2 attached of 2 required

L L

Signature and Submittal

Signature Click the “Sign” button

Submittal

* Sign | Pending
X | submit |

Delete Application |

Customer Support Home | Help | Print To PDF

Copyright @ 2018 B2Gnow. All rights reserved.
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Step 17: “Sign” the document by typing your Signature (full legal name) and Your Title
Step 17A: Click the checkbox to attest that the information contained is accurate and a correct representation of the business
Step 17B: Once steps 17 and 17A are complete, click the “Sign Application” button

(===
e@|° https://test. mwdbe.com/FrontPage/VendorMain.asp?XID=2022 o-ac || @ Diversity Management Syst... % | | {nt %7 €22
File Edit View Faverites Tools Help
>
Test Certification Application: Sign Application Help & Tools 2§
System
Main | Decuments ] Signature: l Submit ] utilities | Gert List
B2GNeVY HDOT Ghost ication status: CO Pending Signature > Sian Application
Appli ion Type: EXpansion Application Application started: 2/28/2018
- = &  Application Number: 1
Home The electronic signature attests to the accuracy of the certification application.
View >
* required entry
Search »

Electronic Signature

— L pm——— 1%t: “Sign” the document by typing your

B (type your full, legal name)
Settings »

Your Title = President .
e full legal nam d Your Titl
e = Your Organization * HDOT Ghost ull legal name an our tite
ogo
Sheow All Hide A1l Today's Date * 2/28j2018 (mm/dd/ )
] By electronically signing this cerfification application, | hereby attest that the information contained Pin and attached in electronic format is accurate and correctly represents the business, its

owners, and its management.

Sign Application ] [ Cancel ]

Customer Support
Copyright © 2018 B2Gnow. All rig

Home | Help | Brint To PDF

2"9: Click the
checkbox to attest

that the information 3": Click the
contained is accurate “Sign
and a correct Application”
representation of button
the business

Logged on as:
Ghost Lee
HDOT Ghost >
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Step 18: Click the checkbox “... I acknowledge individually, and on behalf of the applicant business, the policies, rules and
requirements of the program.”
Step 18A: Once steps 18 is complete, submit the document by clicking the “Submit Application” button

e =]
Q@|° https://test. mwdbe.com/FrontPage/VendorMain.asp?XID=2022 £ - @ & || @ Diversity Management Syst.. % | | ok
Edit View Favorites Tools Help
>
Tast Certification Application: Submit Application Help & Tools 2%
System
Main Docllments] Signaturs ] Sllhmill Uﬁlilles] Cert List
B2GNeYY HDOT Ghost Application status: € & Si , Pending Submittal > Submit Application
Application Type: Expanslon Application

Appl

MNumber:

Application startad: 2/28/2018

S N - )

Home
View Submit Your Application

If you are ready to submit your application, check the box below and click Submit Application. Once submitted, the application g
Message »

o) By submitting this certification application, | acknowledge individually, and on behalf of the applicant busg
Settings » program

nd. . . . “” .
biip 5 Support > E - 2"%: Submit the docymejnt by clicking the “Submit ¥
o Application” button

Show All Hide All

Home | Help | Print To PDF

1%t: Click the

checkbox “... |

acknowledge
individually, and

on behalf of the
applicant
business, the
policies, rules and
S requirements of

Ghost Lee
HDOT Ghost
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Step 19: If you would like a copy of your application (strongly suggested), click on “View and Print Application” button
Step 19A: If you would like to edit your application, click on “Edit Application” button
Step 19B: Click on “OK” in the dialogue box that pops up

= | Ee =5y
e@|° https: //test. mwdbe.com/FrontPage/VendorMain.aspTXID=2022 D-ac || 0 Diversi ty Management Syst... | | ﬁ i\\? {‘3}
File Edit View Favorites Tools Help

Certification Application: Submit Application

Help & Tools 3%

Application status: Complete & Signed, Pending Submittal > Submit Application
Application started: 2/28/2018

Main Dcu:llments] Signalure] Suhmill Utililies] Cert Lisi]
B2GNe\Y HDOT Ghost

Application Type: Expansion Application
&= =5 =) 9041

~ e 15t If you would like a copy of your application (strongly suggested), click

:-:r» Submit Y A . . . . Vi Y Applicati
. RN On “View and Print Application” button ;ew eur fppes "l’"

Edit Your Application

Help & Support »

s 2"d: If you would like to edit your application, click on “Edit Application”
= button

Customer Support

Home | Help | Print To POFE
Copyright © 2018 B2Gnow. All rights reserved. Message from webpage

@>% Submit application? This application cannot be recalled or edited once
' submitted.

Wou will have the opportunity to print your application once submitted.

[ oK | [ Cancel

3rd: Click
on “OK”

in the
dialogue
ety box that

HDOT Ghost
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Step 20: Click on “View and Print Application For Your Records” button

g°|° https://test. nwdbe.com/FrontPage/VendoriMain.asp?XID=2022 L-ac || & Diversity Management Syst... * | |

File Edit View Favorites Tools Help

Tast Certification Application: Submit Application
System

Main Dcl:llmenls] Signature ] Suhmitl QEA ] Utilities ] Cert List

B2Z2GNeYY HDOT Ghost Fe=irem Simien o i ing R

Application Type: Expansion Application
Pt

Application started: 2/28/2018
&= =3 =] Number: 1 Submitted: 2/28/2018
Home Mahalo {thank you) for your submittal. Your certification application number is 9041681. Please reference this number in all correspondence.
View > Applicants can expect to receive a final determination on their application within 90 days. During this time, you may be contacted to supply additional information and/or supporting documentation; a delay in your respense will result in an extended period of review._
Search > HDOT reserves the right to inspect in person and/or request original documents by mail of any supporting document at any time during the term of certification.
Message »
Settings » View and Print Application For Your Records

Help & Support »

Click on “View and
Print Application For
Your Records” button

Chost Lee
HDOT Ghost
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Now you have completed the Expansion Application due to
Change/ Update in NAICS Code

Next step is for HDOT OCR to review your Expansion Application



Questions, Comments, Input, Suggestions, Corrections?

Hawaii Department of Transportation

Office of Civil Rights
hdot-dbe@hawaii.gov
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